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Please share with us: 

• Your Name 

• Your Section/Unit 

• # Years with the UN 

• Interesting Fact About Yourself 

 

 

 

Introduction 
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Please consider the following guidelines during the training session: 

• Turn your cell phone to silent mode.  Please step out of the class to take any 
important phone call 

• Please do not access your e-mail or the Internet outside of breaks 

• Participate fully in the training session and respect each other’s contribution 

• Breaks are included at the discretion of the trainer 

 

 

Ground Rules 
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X X 

No Phones Ask Questions Participate Breaks Do Not Access 
E-mail 
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Course Overview 

The purpose of the Umoja Advanced BI Navigation is to explain the Business Intelligence 
(BI) reports.  This course will also explain the steps to add and modify analysis and charts.  

 

Prerequisite Review 

You should have completed the following prerequisite courses: 

• Umoja Overview 

• Umoja Master Data & Coding Block Overview 

• Umoja BI Navigation 

 

Course Duration: 6 hours 

5 
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Course Objectives 

After completing this course, you will be able to: 

• Describe Umoja Business Intelligence (BI) reports 

• Explain how to access the Online Analytical Processing (OLAP) tool 

• Explain the steps to define, modify, add and delete an Analysis Workspace 

• Explain the steps to add and customize charts within an Analysis Workspace 

• Explain the steps to save, send and print an Analysis Workspace 

6 
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Module 1 Objectives 
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After completing this module, you will be able to: 

• Describe the purpose and capability of Umoja BI 

• Explain the difference between Web Intelligence (WebI) Reports and Analysis 
Workspaces 

• Access and navigate through an Analysis Workspace  

• List the icons used in the Analysis Workspace 
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Key Term Description 

BI Portal 
Web-based application that is used to access the Umoja BI 
system. 

Web Intelligence (Webl) 
Pre-formatted, static reports, which are available for all BI 
users, depending on process area.   

Analysis Area/Workspace 

BI Tool only available to specific BI users that can be used as a 
starting point to create complex, ad-hoc, queries 
instantaneously.  Analysis Areas are separated by process.  For 
example, certain users have access to the Purchase Order 
Analysis Area, the Funds Management (FM) Analysis Area, etc. 

Key Figures 
The measures that describe values, quantities, or other 
numerical metrics.   

Characteristics 
Fields that are used to “slice and dice” data in an analysis, such 
as Vendor or Cost Center. 

Key Terminology 

9 
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Key Term Description 

Attributes 

Refers to the breakdown of certain characteristics to a deeper 
level, offering detailed options not necessarily available in 
Umoja ECC.  For example, region of supplier, lifecycle status of 
grant or fund type 

Key Terminology 

10 
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Roles & Responsibilities 

The following Umoja Enterprise role is involved in the Umoja BI Advanced Navigation 
process: 

11 

BI Power User 

• Access to view and analyze collections of Umoja data 
related to a specific process area.  For example, Funds 
Management BI Power Users can access FM-related 
data elements. 

• In addition to Power Users are able to:  
• View, query, and manipulate sets of data for ad-

hoc requirements using the Analysis Workspaces 
• Save Workspaces to share Analysis with other 

power users 
• Access formatted Web Intelligence reports 

viewable by all BI Users.  For example, a trial 
balance report  
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BI Overview 

12 

Umoja BI refers to the data and reporting tools that are used to support decision making 
across the organization.   

 
Umoja BI: 

• Consists of components that support data management and modeling through the 
use of analytical tools 

• Provides UN with historical and current view of operations 

 

Umoja BI is an application distinct from ECC and SRM, both of which may offer their own 
individual reports: 

Umoja ECC Umoja BI Umoja SRM 
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Umoja BI Reports 
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*The 24 hour time lag exists because it takes time and processing to reorganize data to support 
complex reporting. 

Umoja BI 
Umoja BI reports are: 

• Created by accessing information from 
several data sources  

• Not based on exact real-time data due 
to a maximum lag of 24 hours* 

• Accessed via the BI web portal by 
selecting the appropriate folder 
and/or link 

• Able to create graphical 
representations of data 
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Types of BI Reports 
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Web Intelligence Reports (WebI) Analysis Workspaces 

WebI reports are formatted reports 
that BI Users and BI Power Users can 
view from the BI portal. 

Analysis Workspaces are ad-hoc, 
custom queries that BI Power Users 
can access and edit within the BI 
portal. 

There are two specific types of reports that BI Users and/or BI Power Users can review 
and generate within the Umoja BI portal.  These reports are as follows: 
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Analysis Areas 

Data that is available within the Analysis Workspace tool is organized in Analysis Areas.  
Each Analysis Area contains the characteristics and Key Figures (measures) associated 
with that process.  For example, the Purchase Order Analysis Area contains 
characteristics such as Cost Center and Purchasing Group. 

15 

In other words, the Analysis Area is a blank slate which gives you the tools you need to 
build customized analyses and reports.   
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Overview – Analysis Areas 

The following Analysis Areas are available in the Umoja BI system: 

 

16 

Note: This is only a partial list of Analysis Areas.  More reports will be added to Umoja over 
a period of time.  Please refer to the Advanced BI Job Aids for more information about 
each of these Analysis Areas. 

Real Estate 

• Real Estate Conditions 

• Real Estate 
Measurements 

• Real Estate Cash Flow 

• Real Estate Occupancy 

• Real Estate Contract 
Measurements 

Supply Chain 

• Requisitions  

• Purchase Orders  

• Solicitations 

• Contracts  

• Vendors 

General Ledger (G/L) 

• Trial Balance  

• G/L Line Item 

Funds Management (FM) 

• Funds Management 

• Budget Consumption (Detailed) 

• Budget Consumption 
(Summary) 
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Overview – Funds Management Area 
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An overview of the FM Area is provided below: 

• The Funds Management Analysis Area compiles FM records from Umoja ECC with 
some from IMIS.  This is necessary because there are no other reports that compile 
information from thee two sources in one location 

• The Budget Consumption Summary and Budget Consumption Details Analysis Areas 
display consumable and available budgets 

Description 

• Finance Officers can track the budget availability of a Fund, Funds Center or 
Functional Area 

• Chief Finance Officer of a mission, Special Political Mission (SPM) or UN office can 
review available budget 

• Grant or Fund Manager can request G/L accountant for a Funds Balance report to 
track statuses of budgets 

Purpose 
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Funds Management – Analysis Area 
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Click the Funds Management folder to view the full list of Funds Management Analysis 
Area. 
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Overview – General Ledger Area 
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An overview of the G/L Area is provided below: 

• The G/L Line Item Analysis Area lists all Financials (FI) documents for a given period 
along with account assignment objects such as Fund, Grant, and Business Area 

• The Trial Balance Analysis Area shows the opening balance, total debit movement, 
total credit movement, total net movement, and ending balance in columnar format 
for any given period 

Description 

• Although Umoja provides standard Balance reports, there is no standard ECC report 
with the classic trial balance column format that runs by Business Area, Fund, Grant or 
Segment.  This is provided by the Trial Balance Analysis Area 

• Financial Staff and Accounting Officers can use the G/L Line Item Analysis Area to get a 
complete picture at all direct entry documents that have been entered into the Umoja 
G/L 

Purpose 
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Finance – Analysis Area 

20 

Under the Folders section, you can view different folders and sub-folders for each 
process area.  The sub-folders under the Finance folder are: 

• Account Receivables 

• Accounts Payable 

• Funds Management 

• Grants Management 

Note: The navigation slides are based on the Finance Analysis Area but you should select the 
correct process area in relation with the assigned role. 
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Accounts Receivables – Analysis Area 
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Click the Accounts Receivables folder to view the full list of Accounts Receivables 
Analysis Area. 
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Accounts Payable – Analysis Area 
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Click the Accounts Payable folder to view the full list of Accounts Paybale Analysis Area. 
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Grants Management – Analysis Area 
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Click the Grants Management folder to view the full list of Grants Management Analysis 
Area. 
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Overview – Supply Chain Area 
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An overview of the Supply Chain Area is provided below: 

• The Requisitions, Purchase Orders, Solicitations, and Contracts Analysis Areas 
provide aggregated measures and detailed analysis based on data from Umoja SRM 

• The Vendor Analysis Area provides information about Business Partners classified as 
Vendors in Umoja and United Nations Global Marketplace (UNGM)  

Description 

• Procurement officers and related personnel can view metrics concerning SRM 
documents in an ad-hoc fashion.  While SRM provides detailed information about 
each purchasing document, aggregate reporting is not as readily available 

• Users without access to either Umoja SRM or UNGM can view comprehensive metrics 
as well as bidding and contractual histories for vendors in Umoja 

Purpose 
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Supply Chain – Analysis Area 
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Similarly, some of the sub-folders that can viewed under the Source To Acquire folder 
are: 

• Materials Management 

• SRM 
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Materials Management – Analysis Area 
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Click the Materials Management folder to view the full list of Material Management 
Analysis Area. 
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SRM – Analysis Area 
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Click the SRM folder to view the full list of SRM Analysis Area. 
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Overview – Real Estate Area 
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An overview of the Real Estate Area is provided below: 

• The Real Estate Conditions, Measurements, and Occupancy Analysis Areas provide 
data relevant for the Portfolio Management process.  Portfolio Management defines 
the real estate infrastructure and manages business partner relationships. 

• The Real Estate Cash Flow and Contract Measurements Analysis Areas provide data 
relevant for the Lease Administration process. 
 

Description 

• Real Estate data found in OLAP Analysis Areas provide data of operational and 
strategic interest to Facilities Managers throughout the organization. 

• Real Estate Power Users are able to report on both the Architectural View (functional 
data) and Usage View (financial data) regarding Real Estate assets 
 

Purpose 
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Real Estate – Analysis Area 
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Click the Real Estate folder to view the full list of Real Estate Analysis Area. 
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The steps to access an Analysis Workspace are: 

• Log in to the BI portal 

• Click the Documents tab 

Access Analysis Workspace 

30 

1 

2 

Note: In the My Documents section, you will see any workspaces that you have saved to 
your personal folder (Saving workspaces will be covered later in the course). 

2 
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• Click the Folders tab 

• Click the appropriate folder.  A list of folders that align to your process (for example, Real 
Estate) will be displayed.   

• Navigate through the folders to find the full list of Analysis Areas 

• Double-click the title of an Analysis Area to open it in a new tab 

Access Analysis Areas 

31 

3 

4 

5 

6 

Note: The Shared Analysis folder is used for all customized reports or workspaces which 
other users have shared publically.  If you would like to share your analyses with others, they 
must be saved in this folder. 

3 

4 

6 
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Navigating Analysis Workspaces 
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The screenshot below highlights the different navigational elements of an OLAP Analysis Area 

Task Panel 1 Layout Panel Metadata Explorer 3 Analysis Window 4 

1 

3 

2 

4 

2 
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Navigating Analysis Workspaces 
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Task Panel 

The Task panel is located on the left side of the screen.  The three icons on the left side of the 
panel can be used to change the information that appears in the panel.  These three icons are 
as follows: 

• Data 
The Data icon opens the Data tab that is used to add or 
remove data sources from the analysis.  It is also used to 
perform navigation functions, such as adding a hierarchy 
to rows or columns, adding a background filter or adding 
a favorite grouping 

 
• Properties  

The Properties icon opens the Properties tab that 
displays the configurable properties of the selected 
component, for example, column width or chart style 
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Navigating Analysis Workspaces 
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Task Panel 

• Outline 
The Outline icon opens the Outline tab that provides an 
overview of the current workspace that can be useful 
when the workspace contains many sheets.  This tab 
enables the user to quickly switch to another analysis in 
the workspace and to remove any analysis that is 
currently not in use 

Note: The Task panel also displays specific tasks, such as the Calculation, Filter and 
Conditional Formatting panels.  You can hide the entire Task panel to maximize the 
Analysis window size.   
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Navigating Analysis Workspaces 
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Layout Panel 

The Layout panel is the panel adjacent to the Task panel.  In this panel, you 
can: 

• Drag and drop different hierarchies and measures into the rows or 
columns of your analysis, similar to a Pivot table in Excel 

• Drag and drop different measures as a background filter to your 
analysis 

• Perform navigational operations on hierarchies and measures including 
filtering, re-ordering and swapping objects 

Note: You can hide the Layout panel to maximize the Analysis window size. 
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Navigating Analysis Workspaces 
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Metadata Explorer 

The Metadata explorer resides within the Data         tab 
and displays the Key Figures and Characteristics 
contained in a displayed data source.   
 
For example, if the FM data source is selected, all the Key 
Figures related to FM, such as Down Payments or 
Appropriations, are displayed.  
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Navigating Analysis Workspaces 
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Analysis Window 

The Analysis window is the primary 
part of the screen displaying the rows 
and columns in a spreadsheet form for 
the selected data.   
 
It is located to the right of the Layout 
panel.  This window displays the core 
components of the Analysis Area 
report. 
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Navigating Analysis Workspaces 
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Chart 

A chart is a bar, line or any other type of 
chart object that is added to the Analysis 
window to visualize the data in the 
analysis.   
 
There is the option of adding more than 
one chart type.  These additional charts 
display adjacent to each other and can be 
moved around on the screen, as required. 

 



Copyright © United Nations Copyright © United Nations 

Icons used in Analysis Workspaces 
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Name Icon Description Examples 

Key Figures 
Numerical values which are 
measured in the analysis 

Invoices (value) and 
Quantity 

Single Figure 

By default, all Key Figures are 
displayed in an analysis.  Single 
figures/metrics can be displayed 
instead 

 
Same as above 

Characteristic 
Fields in Umoja that are used to 
differentiate and analyze Key 
Figures 

Fund and Purchasing 
Organization 

Attribute 
Used to describe characteristics in 
more detail 

Attributes of 
Location/Plant are Country 
and Local Currency 

Filter 
Enables filtering the analysis on a 
specific characteristic or set of 
characteristics 

Filtering an analysis only 
on the current posting 
period 

The frequently used icons when working with Analysis Workspaces are as follows: 
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Structure of an Analysis Workspaces 
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Key figures and characteristics are the main components of an Analysis Workspace.  By 
default, all Key Figures for a specific Analysis Area are set in the Columns section of the 
analysis, while any characteristics are placed in the Rows section. 

 

In the example below, the Key Figures for the Purchase Requisition Analysis Area are 
separated into each column, while the chosen characteristic, Purchasing Group, is listed 
by row. 

Rows Columns 
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Learning Checkpoint 1 

41 

A. Task panel 

B. Layout panel 

C. Analysis window 

D. Chart 

Which of the following elements is the primary part of the screen displaying the rows 
and columns in a spreadsheet form for the selected data? 

Select the correct option: 
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Learning Checkpoint 1 

42 

A. Task panel 

B. Layout panel 

C. Analysis window 

D. Chart 

Which of the following elements is the primary part of the screen displaying the rows 
and columns in a spreadsheet form for the selected data? 

Select the correct option: 

Option C is the correct answer.  The Analysis 
window is the primary part of the screen displaying 
the rows and columns in a spreadsheet form for 
the selected data. 
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Module 1 Summary 

The key points covered in this module are listed below: 

• Analysis Workspaces can be accessed by clicking the Documents tab in the BI portal 

• The Task panel has three icons that are used to change the information that 
appears in the panel.  These three icons are Data, Properties and Outline 

• The Layout panel is used to drag and drop hierarchies and measures.  It is also used 
to perform navigational operations on hierarchies and measures 

• The Metadata explorer displays the measures contained in a displayed data source 

• The Analysis window is the primary part of the screen displaying the rows and 
columns in a spreadsheet form for the selected data 

• A chart is a bar, line or any other type of chart object that is added to the Analysis 
window 

 

 

 

43 



Copyright © United Nations Copyright © United Nations 

Agenda 
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Module 2 Objectives 

After completing this module, you will be able to: 

• Define a new analysis 

• Modify an analysis in a Pre-Built Workspace 

 

45 
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Define a New Analysis 

46 

When you open an Analysis Area, by default all Key Figures are listed in the Columns section, while 
one or more characteristics are in the Rows section. 

 

 

Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

Funds Management Analysis Area 
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Define a New Analysis 

47 

The steps to modify the Key Figures in your analysis 
are as follows:  

• Drag the Key Figures label from the 
Columns section into the Data panel 

• Expand the Key Figures label in the Data 
panel 

• Drag the desired Key Figure back into the 
Columns panel 

 

The          icon next to Key Figures will turn into a 
Filter icon. 

Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

2 

1 

2 

3 

1 
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Define a New Analysis 

48 

Alternatively, you can include/remove the Key 
Figures by using a filter: 

• Right-click the Key Figures label in the 
Columns section 

• Select the Filter > By member… list item 

A Filter “Key Figures” pop-up window appears. 

  

• Check the Key Figures that you would 
like to include   

• Click the OK button 

 

Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

3 

1 

2 

4 

Note: This method is preferable when 
multiple Key Figures are selected to be 
included rather than just one or two. 

1 

2 

3 

4 
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Define a New Analysis 
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Next, you can add Characteristics to the analysis.  There are 
several ways to do this: 

• To add the selected Characteristic to the rows of the 
analysis, drag it to the Rows area 

• To add the selected Characteristic to the columns of the 
analysis, drag it to the Columns area 

• To add the hierarchy to the background filter, drag it to 
the Background Filter area.  You will then be prompted 
which members of the Characteristic should be filtered 

 

Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

6 

7 

6 

5 

7 
Note: While placing members of a measures dimension 
into an analysis, they can also be dragged directly into 
the rows or columns of the workspace area. 

5 
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Define a New Analysis 

50 

Alternatively, you can use the icons above the 
Metadata explorer on the Data panel to populate the 
workspace. 

Select a component in the Analysis window and then 
click one of the following icons to add the elements to 
the analysis:  

• Click the Add to Rows        icon to add the 
selected element to the rows on the crosstab 

• Click the Add to Columns        icon to add the 
selected element to the columns on the 
crosstab 

• Click the Add to Background Filter        icon to 
add the selected element to the background 
filter 

 

Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

8 

9 

10 

8 9 10 
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Define a New Analysis 
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Note that the order of Characteristics in the Rows section influences how the data is summarized.  
In this example, because Funds Center is below Budget Period, data is summarized by Budget 
Period, then Funds Center. 

 

• To re-order the Characteristics, simply drag them up and down in the Rows section. 

Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

11 

11 
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Define a New Analysis 
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Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

If automatic updating is turned on, the crosstab and chart components update as you add hierarchy 
to the Layout panel, causing short delays.  
 
• Click the Auto Update button on the toolbar to turn off automatic updating 

 
12 

12 
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Define a New Analysis 
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Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

There may be a case where the Key Figures of an analysis do not adequately capture your 
requirements.  In these cases, you may need to perform a calculation.   
 
Let’s look at an example from the Purchase Requisition Analysis Area.  In this analysis, the Key 
Figures include the total number of Shopping Carts that have been submitted for approval as well 
as the number that have been approved, by Purchasing Group. 
 
In this example, we will create a new calculation that will show the number of Shopping Carts that 
have been submitted for approval but not yet approved. We will arrive at this number by 
subtracting the total approvals from the total submissions. 
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Define a New Analysis 
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Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

To do this: 

• Click the Analyze tab 

• Click the arrow button next to Calculations 

• Click Custom Calculation… This will open a pop-up window. 

 

1 

2 

3 

1 

2 

3 
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Define a New Analysis 
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Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

 

• Enter a name for your calculation in the Name field 

• Click the Add Member button 

• In another pop-up window, select the Key Figure(s) that 
are to be included in your formula.  This will bring the 
variables into the Function window. 

• Click the Function button to find standard functions, such 
as MIN, SUM, AVG, etc. (similar to Excel).   

• Otherwise, use standard operators like “+”, “-”, etc. to 
perform basic mathematical operations on your variables 

• Click OK when finished 

 

 

4 

5 

6 

7 

8 

9 

4 

5 7 

8 
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Define a New Analysis 
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Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

Now the new calculated Key Figure will appear as a new column. It can be dragged to another 
position in the analysis and acted on just as any other Key Figure. 
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Modify an Analysis  

57 

Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

 

 

In addition to the OLAP Analysis Areas, there are also pre-built OLAP Workspaces available to 
modify.  
These are just the same as normal Analysis Areas, except the rows, columns, filters, and calculations 
have been already set up in advance. 
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Modify an Analysis  

58 

Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

 

 

Navigating to these Pre-Built Workspaces is 
similar to standard Analysis Areas. 
 
In the example FM folder to the right, there 
are many pre-built WebI (Web Intelligence) 
reports.  
 
Below them is the FM Analysis Area.   
 
Finally, there are two pre-built OLAP 
workspaces at the bottom of the list. 
 
• Double-click these to open them in a new 

tab. 
1 

1 
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Modify an Analysis  
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Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

 

 

When you open a Pre-Built Workspace, you 
may need to enter initial criteria to load the 
data.  
 
• In this case, to load the Budget 

Consumption Summary workspace, you 
must populate Budget Period and Fund 
fields.  This will set up a filter on the 
available data using these two values 
 

• Click the OK button to proceed 

2 

3 

2 

3 

2 
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Modify an Analysis  
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Define a New Analysis 
Modify an Analysis in a Pre-Built 

Workspace 

 

 

In the resulting Workspace, you can see that several Key Figures and characteristics have been pre-
loaded into the analysis.   

Just like in an Analysis Area, the columns and rows can be modified as you see fit.  Later, we will 
discuss saving a Workspace that you’ve customized for later use. 
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Learning Checkpoint 2 

In an Analysis Workspace, a calculation can be performed on which of the following? 

 

Select the correct option: 

A. Characteristics  

B. Analysis Areas 

C. Key Figures 

D. Hierarchies 

E. Attributes 

61 
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Learning Checkpoint 2 

In an Analysis Workspace, a calculation can be performed on which of the following? 

 

 Select the correct option: 

A. Characteristics  

B. Analysis Areas 

C. Key Figures 

D. Hierarchies 

E. Attributes 

62 

Option C is the correct answer.  Key Figures are 
numerical values, so they can have calculations 
performed on them. 
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Simulation Activities 

Throughout this training, users will have the opportunity to 
conduct activities in the form of simulations.  Simulations 
are interactive “recordings” of the Umoja system used to 
help facilitate a hands-on learning experience.  The 
simulation links are provided on the corresponding activity 
slides. 

 

Users can access simulations in three different modes:  

• Show me: Users view a video of an entire transaction 
being conducted  

• Let’s do it together: Users will be prompted to input 
data at key points during the transaction 
(recommended) 

• Try it: Users can complete an entire transaction on 
their own, with no additional instructions provided 

63 Copyright © United Nations 
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Activity 1 

Transaction Name: Define a New Analysis and add 
Calculation 

 

Guide me:  Define a New Analysis and add Calculation 

64 Copyright © United Nations 

https://umoja.un.org/sites/umoja.un.org/files/nv301-define_a_new_analysis_and_add_calculation.pdf
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Activity 2 

Transaction Name: Open and Modify an Existing 
Workspace 

 

Guide me: Open and Modify an Existing Workspace 
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https://umoja.un.org/sites/umoja.un.org/files/nv301-open_and_modify_an_existing_workspace.pdf
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Module 2 Summary 

66 

The key points covered in this course are listed below: 

• An analysis can be defined by populating a crosstab with the data options that are 
to be included.  It can also be defined using a chart component 

• The three axes in the crosstab are row axis, column axis and background filter or 
slice axis 

• The two hierarchies in the crosstab are row and column hierarchies and 
background filter hierarchies 



Copyright © United Nations Copyright © United Nations 

Agenda 
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Module 3 Objectives 

After completing this module, you will be able to: 

• Add a sub-analysis 

• Describe charts in analysis 

• Add a chart 

• Change a chart type 

• Customize a chart 

• Explain the Chart Range Slider and Conditional Formatting functionalities 

 

68 
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Create a Sub-Analysis 

69 

When an Analysis Area is opened, an analysis is 
automatically created by default.  For some Analysis Area 
reports, only one analysis is required.  However, in other 
cases, an additional sub-analysis may be required. 

  

A sub-analysis is linked to the original analysis.  However, 
the new component from the original can be unlinked, 
creating a separate analysis. 

 

The steps to create a sub-analysis are as follows: 

• Click the Insert tab at the top of the screen 

• Click the relevant Chart icon 

• Select Insert a sub-analysis 

Create a Sub-Analysis Delete an Analysis 
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Create a Sub-Analysis 
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A new window will open next to the 
original analysis.  To focus the sub-
analysis on a specific set of data, 
perform the following steps: 

• Select one or more rows or 
columns in the original analysis 

• Click the Focused Analysis 
button in the Display tab.  This 
limits the sub-analysis to only 
the selected data in the 
original analysis 

• Click the Update  
Sub-Analysis button, if you do 
not want the sub-analysis to 
keep updating based on these 
selections 

Create a Sub-Analysis Delete an Analysis 
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Delete an Analysis 
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The steps to delete an analysis are as follows: 

• Select the analysis from the Outline panel 

• Click the Delete icon 

Create a Sub-Analysis Delete an Analysis 
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Overview of Charts in Analysis 
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Charts are added to workspaces to present data graphically and are used to indicate 
irregularities or trends in data.  Several chart types available to visualize data are as 
follows:  

• Clustered bar and column charts 

• Stacked bar and column charts 

• 100% stacked bar and column charts 

• 3D column charts 

• Multi-line charts 

• Pie charts 

• Scatter charts 

• Box plot charts 

• Bubble charts 

• Radar charts 
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Overview of Charts in Analysis 

73 

Chart and crosstab components are linked to analyses.  A common analysis scenario is to 
first create a crosstab and then add a chart as a sub-analysis linked to the main analysis.  
The crosstab and chart display the same data and both get updated simultaneously 
whenever changes are made. 

 
Focused analyses are used to display only a subset of the data in the main analysis.  For 
example, you can use a crosstab for your main analysis and use a chart for the focused 
sub-analysis.  As a result, when you select data in the crosstab, the chart displays only the 
selected subset of data. 
  
This module will cover the following activities related to charts: 

 

Add a Chart Change a Chart Type Customize a Chart 
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Add a Chart 

74 

The steps to add a chart to the Analysis window are 
as follows: 

• Click the required Chart icon or drag the Chart 
icon to the Analysis window to add a chart 

 

The chart is added below or to the right of the 
existing components in the sheet.   

1 

Add a Chart Change a Chart Type Customize a Chart 

1 

Note: Some chart icons represent families of individual chart types.  For example, 
the column chart family includes charts such as stacked column and 3D column. 
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Add a Chart 

75 

When you add a chart to a sheet, the chart is added as a sub-analysis linked to the selected analysis.   

Therefore, the chart is automatically populated with data that has been previously defined in the 
analysis. 

Add a Chart Change a Chart Type Customize a Chart 
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Change a Chart Type 
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The steps to change a chart type are as follows:  

• Select the required chart and click the Insert tab 

• Click the Switch to drop-down list 

• Select the chart type that you want to switch to from the displayed list.  Alternatively,  
right-click the chart graphic and select the chart type to be used 

Add a Chart Change a Chart Type Customize a Chart 
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Customize a Chart 
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Multiple options available for customizing a chart on the 
Properties         tab are as follows: 

• Sub-Analysis Name: The name that you type here 
appears on the chart's title bar and is used to identify 
the chart on the Outline panel 

• Description: This text is included when you print the 
chart 

• Style, Palette and Font: Select from different options to 
modify the look and feel of the chart 

Add a Chart Change a Chart Type Customize a Chart 
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Customize a Chart 
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• Show totals: If you have totals displayed on the 
crosstab, click this check box to show these totals in 
the linked chart 

• Show hierarchical labelling: Click this check box to   
show the parent-child relationships between the 
members on the chart 

Add a Chart Change a Chart Type Customize a Chart 
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Customize a Chart 

79 

• Show legend: This toggles the display of the chart 
legend 

• X Axis Label, Y Axis Label and Z Axis Label: Type 
labels in any of these following fields to add labels to 
the respective axis 

• Y Axis Scale: Used to modify the scale used on the Y 
Axis of the Chart 

• Y Axis Symbol: Type a symbol to use for the Y Axis 
Scale Symbol property 

Add a Chart Change a Chart Type Customize a Chart 
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While working with large data sets, displaying all the data on a chart makes it difficult to 
distinguish between individual risers or lines on the chart.  In such a scenario, analysis 
adds a range slider to the chart component to help read the data better. 
 
 

Chart Range Slider 
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The chart range slider allows you to pick 
and choose which data elements to 
display in the chart for better visibility. 

 

For example, in the chart to the right, one 
bar is much longer than all the others, 
rendering the chart difficult to read. 

 

 



Copyright © United Nations Copyright © United Nations 

With the chart slider, you can change the range of the chart to view only a subset of the 
data in the analysis.   
 
 

Chart Range Slider 

81 

Note: You can hide the range 
slider by clicking the 
hide/restore button at the 
right edge of the range slider.  
To restore the range slider, 
click the hide/restore button 
again. 

To do this, drag the bars at the edges of 
the sliders to modify which data is 
displayed. Only the section of the slider 
shown in white will display in the chart. 

 

 Drag Up/Down 
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Apply Conditional Formatting 

82 

The steps to apply conditional formatting are as follows: 

• Select Analyze > Conditional Formatting on the 
toolbar.  Alternatively, you can right-click the selected 
cells and choose Conditional Formatting > New 

• Type a name for the conditional format on the 
Conditional Formatting panel.   

• Select a Key Measure in the Based on field.  

• Define the rule for the conditional formatting and click 
the Add button 

• Click OK 

1 

2 

1 

3 

4 

5 

2 

3 

4 

5 



Copyright © United Nations Copyright © United Nations 

Learning Checkpoint 3 

When you add a chart to a sheet, the chart is added as a __________ linked to the 
selected analysis. 

Fill in the blanks with the correct option. 

A. Sub-analysis 

B. Crosstab 

C. Focused analysis 

D. Data set 

83 
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Learning Checkpoint 3 

When you add a chart to a sheet, the chart is added as a __________ linked to the 
selected analysis. 

Fill in the blanks with the correct option. 

A. Sub-analysis 

B. Crosstab 

C. Focused analysis 

D. Data set 

84 

Option A is the correct answer.  When you add a 
chart to a sheet, the chart is added as a  
sub-analysis linked to the selected analysis.  
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Activity 3 

Transaction Name: Add a Chart to a Workspace 

 

Guide me:  Add a Chart to a Workspace 

85 Copyright © United Nations 

https://umoja.un.org/sites/umoja.un.org/files/nv301-add_a_chart_to_a_workspace.pdf
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Module 3 Summary 

86 

The key points covered in this module are listed below: 

• A sub-analysis is linked to the original analysis 

• Charts are added to workspaces to present data graphically and are used to 
indicate irregularities or trends in data 

• Several chart types are available to visualize data  

• A chart can be customized to modify the display or functional features 

• The chart range slider allows you select a portion of the data set and view it in an 
expanded form in the main chart graphic 

• A row, column or a group of cells can be selected to apply conditional formatting 
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Module 4 Objectives 

After completing this module, you will be able to: 

• Save analysis workspaces for sharing with others 

• Send an analysis workspace 

• Print BI reports and files 

 

88 
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Overview 

89 

Save an Analysis 
Workspace to Share 

with Others 

Send an Analysis 
Workspace to Another 

User 

Print BI Reports and 
Files 

This module will cover the following activities: 
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Save an Analysis Workspace 
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To save an Analysis Workspace in a location 
where others can access it, you save the 
workspace to a public folder in the BI platform 
repository.  To do this: 

• Click the arrow beside the Save button 
on the toolbar and select Save As 

• Click the Folders bar, under My 
Documents 

• Within the Umoja Foundation folder, 
click the Shared Analysis folder.  All BI 
Power users have access to this folder 

• Type a filename for your workspace in 
the Filename field 

• Click the Save button 

Save an Analysis 
Workspace to Share 

with Others 

Send an Analysis 
Workspace to Another 

User 

Print BI Reports and 
Files 
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Send an Analysis Workspace to Another User 
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Save an Analysis 
Workspace to Share 

with Others 

Send an Analysis 
Workspace to Another 

User 

Print BI Reports and 
Files 

The Umoja BI portal allows you to send a workspace 
to another BI user or to an e-mail recipient.   

 

If you have any unsaved changes in your workspace, 
the workspace is first saved with a unique name in 
your Favorites folder.  You can then send the saved 
workspace to an email recipient using the Email 
button: 
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Print BI Reports and Files 
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Save an Analysis 
Workspace to Share 

with Others 

Send an Analysis 
Workspace to Another 

User 

Print BI Reports and 
Files 

You can export workspaces to PDF files, which can be printed or sent to colleagues. 

After completing the analysis, findings might have to be shared by exporting the workspace to a PDF 
file or by printing the data.  Using the printing capability in analysis, you can perform the following 
activities: 

• Print Data – Choose to print raw data instead of the crosstab or chart representations of the 
data.  When the data printing option is chosen, all the filtered data in an analysis is printed 
instead of the data visible on the screen 

• Print Sheet – When a sheet is printed, all components on the sheet are printed together, as 
they appear on the screen 

Note: Analyses and charts are printed as they appear on screen with minor exceptions.  Text 
that does not fit within the column widths may be truncated and appear differently from 
how they are displayed on the screen. 
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Print BI Reports and Files 
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Save an Analysis 
Workspace to Share 

with Others 

Send an Analysis 
Workspace to Another 

User 

Print BI Reports and 
Files 

The steps to export BI reports and files to PDF are 
as follows: 

• Click the Print icon 

• Select Sheet or Data 

• Select one or more sheets to be printed if 
Print a sheet is chosen.  Press the Ctrl or 
Shift key to select multiple sheets 

• Select a Paper Size and Print Orientation 

• Choose the information fields you want to 
display in the header and footer 

• Click the OK button  
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Learning Checkpoint 4 

For other users to be able to access a Workspace that you have saved, it must be saved 
into which folder? 

Select the correct response. 

A. My Documents 

B. My Favorites 

C. Public Umoja Analysis 

D. Shared Analysis 

94 
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Learning Checkpoint 4 

For other users to be able to access a Workspace that you have saved, it must be saved 
into which folder? 

Select the correct response. 

A. My Documents 

B. My Favorites 

C. Public Umoja Analysis 

D. Shared Analysis 

95 

Options D is the correct answer.  Only the Shared 
Analysis folder is visible to all BI Power Users. 
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Activity 4 

Transaction Name: Save a Workspace and Print as PDF 

 

Guide me:  Save a Workspace and Print as PDF 
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https://umoja.un.org/sites/umoja.un.org/files/nv301-save_a_workspace_and_print_as_pdf.pdf
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Module 4 Summary 
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The key points covered in this course are listed below: 

• Workspaces can be saved to a public folder “Shared Analysis” in the BI platform 
repository to share with other analysts and end users 

• The Umoja BI portal allows you to send a workspace to another BI user or to an e-
mail recipient 

• In case of unsaved changes in the workspace, the workspace is first saved with a 
unique name in the Favorites folder, and then sent to a BI User or e-mail recipient 

• The workspaces can be exported to PDF files, which can be printed or sent to 
colleagues 
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Module 5 Objectives 

After completing this module, you will be able to: 

• Customize an existing WebI report 

• Add a calculation to a WebI report 

• Save an edited WebI report to a private or shared folder 

 

99 
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Web Intelligence Reports 

100 

To review, Web Intelligence (WebI) reports are pre-formatted standard reports available 
to all BI users. 

While most BI users are only able to display WebI reports, BI Power Users can edit pre-
existing reports and save new WebI reports in either a private or shared folder. 
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Edit WebI Report 

101 

When you open a WebI report, it will appear in Reading mode, just as it does for all BI 
users. 

 

To enable editing features, you must click the Design button in the top-right corner of the 
screen.  This will display the formatting and data tabs at the top of the screen. 
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Edit WebI Report 
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One of the most important things to note about the interface is that most components 
within a WebI report can be edited.  This includes all formatting, text boxes, graphics, 
headings, etc.  

 

Secondly, most of these components are edited using the Formula Bar.   

 

 

 

 

 

 

Formulas entered here follow similar rules to Excel.  For instance, if you wanted to name a 
column Column A, you would type: =“Column A” 

 

Similarly, all calculations on Key Figures is performed in the Formula Bar as well. 
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Edit WebI Report 
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To create a new calculation: 

• Highlight a column in the report and click the Formula button.  Alternatively, right-click 
the column and click Edit Formula… 

 

 

 
• Select a Key Figure or other variable 

from the Available Objects window 

• Double click the Key Figure to add it to 
the Formula window.   

• Build the calculation using functions 
and operators available below.   

• Click the OK button 
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Edit WebI Report 
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Creating charts is very similar to OLAP Analysis Areas.  To do this: 

• Under the Report Elements tab, click one of the chart type buttons under the Chart 
tab 

 

 

 

• Your cursor will then turn into a “+” sign and you can choose where on the screen to 
insert a new chart.  The chart will then appear with no data assigned. 
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Edit WebI Report 
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• Righ-click the chart and select Assign Data… The Assign 
Data pop-up window will open 

• For the Category Axis (X-Axis) and Value Axis (Y-Axis), 
select which data objects should be assigned 

• Click OK 

• The chart will update on the WebI report.  Formatting 
options are available by right-clicking on the chart and 
selecting Format Chart Plot Area… 
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Edit WebI Report 
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• To save an edited WebI Report, click the Save button under the file tab.  Only the Save 
As… option is available because all the standard reports are not modifiable. 

• As with OLAP Workspaces, WebI reports must also be saved in to the Shared 
Analysis folder if you want any other BI users to be able to see them.  

• The Print button will immediately export the report as a PDF file ready for quick 
printing 

• The Export button allows you to export the current report as a PDF file, as well as an 
Excel file or text file 
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Learning Checkpoint 5 

The ______ button is only available to BI Power Users and allows them to edit Web 
Intelligence reports. 

Fill in the blank. 

A. Edit 

B. Design 

C. Modify 

D. Display 

107 
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Learning Checkpoint 5 

A. Edit 

B. Design 

C. Modify 

D. Display 

108 

Option B is the correct answer.  The Design button 
enables editing for Power Users in WebI reports.   

The ______ button is only available to BI Power Users and allows them to edit Web 
Intelligence reports. 

Fill in the blank. 
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Module 5 Summary 
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The key points covered in this module are listed below: 

• Only BI Power Users can modify WebI reports 

• Power Users can save modified WebI reports as custom reports for others to view 

• Calculations and formatting are edited in WebI reports in a similar way to OLAP 
reports 



Copyright © United Nations Copyright © United Nations 

Activity 5 

Transaction Name: Edit an existing WebI Report 

 

Guide me:  Edit an existing WebIReport 

110 Copyright © United Nations 

https://umoja.un.org/sites/umoja.un.org/files/nv301-edit_an_existing_webireport.pdf
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Course Summary 
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The key points covered in this course are listed below: 

• Umoja BI refers to the data warehouse and reporting tools that are used to support 
decision making across the organization  

• The two types of BI reports are WebI reports and OLAP reports 

• Analysis Workspaces can be accessed by clicking the Documents tab in the BI 
portal 

• The workspaces can be saved to a public folder in the BI platform repository to 
share with other analysts and end users 

• The workspaces can be exported to PDF files, which can be  
printed or sent to colleagues 

• WebI reports can also be modified and saved as custom reports 
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Course Assessment 

Now that you have completed all the modules in this course, you can test your 
knowledge by completing the Course Assessment. 

 

To receive credit for completing this course, you must pass this assessment with a 
minimum score of 90%. 

 

To complete the assessment you must return to the Learning Management System:  

1. Log into Inspira  

2. Navigate to Main Menu -> Self-Service -> Learning -> My Learning  

3. Search for the name of the course under the My Learning Activities section 

4. Click the Start link of the course assessment  

5. Click the Submit button once you have completed the assessment  
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Course Survey 
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Your feedback is important to the continuous improvement of our training program. 

 

Please complete the evaluation for this course using the following steps:  

1. Log into Inspira  

2. Navigate to Main Menu -> Self-Service -> Learning -> My Learning  

3. Search for the name of the course under the My Learning Activities section 

4. Click the Start link of the course survey 

5. Click the Submit button once you have completed the course survey  
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Congratulations! You have successfully completed the 

Umoja Advanced BI Navigation course. 
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